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OED 214 Word Processing,  
CSC 105 Introduction to Computers 

 

Concepts addressed:  
Keyboarding; production; specialized types of information: statistical, legal, and medical (including legal and 
medical transcription); word processing; proofreading; editing; formatting; graphics; records management; 
database applications; reprographics; processing mail; simulation productivity; equipment use; spreadsheets; 
data security; entering and verifying data; computer literacy; and internet technology  

Keyboarding, Production, Specialized Types of Information 

Keyboarding Keyboarding is a psychomotor skill characterized by coordination and actions relating to fine 
motor skills. Keyboarding focuses on the manipulation of the computer keyboard by touch. Correct 
keyboarding skill is important to maintain good speed and accuracy. Other techniques to follow are sit up 
straight with both feet flat on the floor, keep wrists low and fingers curved, and keep eyes on the copy. 
Production takes into account good formatting requirements such as setting margins and tabs, bold, underline, 
correct spacing, and centering to make documents look attractive. Special types of copy that make accuracy 
important are the specialized types of information such as statistical, legal, and medical documents.  

Proofreading Proofreading is rereading information for accuracy and marking and correcting grammatical and 
spelling errors. While typing using word processing software, words will automatically wrap at the end of each 
line--called word wrap. Other features that are provided are spell checker and grammar checker. The software 
on your computer will automatically underline a word or a section of words to in form you that a mistake has 
been made. To correct these colored underlines, simply hover your mouse arrow over the underlined section 
and right click with your mouse. Then select the appropriate correction that is given. Another aspect of 
proofreading includes making sure that the document is consistent regarding style and tense (e.g. past, present, 
or future). It is suggested that you leave your work after completing it, then come back and proofread it. That 
way, you are guaranteed to catch mistakes that you may have overlooked. You may also consider giving your 
work to another co-worker to proofread. Students should be familiar with revision marks used for the 
following: 

Omitting a character  
Deleting a word  
Changing a word  
Inserting a word  
Inserting a space  
Changing to lowercase  
Using lowercase  
Capitalizing a letter  
Inserting a comma or a semi-colon  
Inserting a period or a colon  
Transposing letters  
Making a new paragraph  

Word ProcessingWord processing is the most widely used commercial application software and is 
used in all work environments. Many features of word processing software are used in business 
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documents so learning these features helps increase productivity in the work environment. Some of 
the features include bold, underline, italics, alignment, margins, tabs, line spacing, font, font size, 
bullets, and spell check.  

Editing Editing is modifying the document. Color and appearance attributes can be added to words 
and titles for a more attractive appearance such as bold, underline and italics. Word processing 
software contains features such as the thesaurus and find and replace. The thesaurus is helpful in 
providing you with synonyms, antonyms, and related words for a selected word or group of words. 
The find and replace feature is useful if you need to find and replace a word or words quickly. For 
example if you were told to replace every instance of 'e-mail' with .email find and replace would 
allow you to perform this in one simple step. This feature is found under the Edit menu on the 
standard tool bar. You can add bullets and numbered lists to your documents. Another way to 
enhance your document is by adding appropriate graphics and pictures.  

Formatting Formatting is the organized layout or appearance of data. The most basic type of 
formatting is the font and the font size. This can be located under the Format menu on the standard 
tool bar. The following graphics are examples of fonts and font sizes.  

Times New Roman 12pt. 

Arial 14pt. 

Comic Sans MS 16pt. 

Eras Light ITC 18pt. 

Lucida Calligraphy 20-pt. 

Formatting can also include how documents are laid out. For example, business letters are to include 
a date and a signature with one-inch margins. Two inches should be left at the top for a header. Next 
should be the date, four blank spaces, the inside address, one blank space, the greeting, one blank 
space, and then the body of the letter. The closing, the signature and the printed signature are 
followed after the body. Any enclosures should then be noted.  

Spreadsheets A spreadsheet is described as a program that is used to analyze data, execute 
calculation, and make charts. The following are some steps to follow to make a spreadsheet:  

• Start by entering information into appropriate columns and rows. Next, calculate each 
column to come up with a total in each group given. You can do this by summing the 
numbers (click on cells you want to add) in the toolbar. Be sure that the total cell is selected 
when calculating a total.  

• After all calculations are finished, you can make a pie chart, to show percentages using the 
data entered. Choose the chart icon and follow the simple steps to making a pie chart.  

• Fonts and formatting help make the information presentable.  

Graphics A graph is a visual representation of a relationship between two variables. A graph 
commonly consists of two axes called the x-axis (horizontal) and y-axis (vertical). Each axis 
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corresponds to one variable. There are many different types of graphics that you can use to display 
your information. The most commonly used graphs are a line graph, pie chart, and bar graph. A line graph is a 
way to summarize how two pieces of information are related and how they vary depending on one another. 
The numbers along a side of the line graph are called the scale. A pie chart is a circle graph divided 
into pieces, each displaying the size of some related piece of information. Pie charts are used to 
display the sizes of parts that make up some whole. Bar graphs consist of an axis and a series of 
labeled horizontal or vertical bars that show different values for each bar. The numbers along a side 
of the bar graph are called the scale. Graphs are quick and direct, highlight the most important facts, 
facilitate understanding of the data, convince readers, and can be easily remembered.  

Databases A database is a collection of related tables. A field is a single characteristic or attribute of 
a person, place, object, event, or idea. A table is a collection of fields that describe a person, place, 
object, event, or idea. Many databases have a primary key to organize or sort the table. A primary 
key is a field whose value uniquely identifies each record in the table. A database management 
system (DBMS) is a software program that lets you create databases and then manipulate data in 
them. Many database software packages allow you to create queries, forms, reports, and labels.  

Entering and Verifying Data Verifying the data that you enter is very important in a job. You need to 
be accurate and cautious in your work to become successful. Use the following steps to verify data:  

• Start by choosing the spell check icon and check the spelling of your document.  
• Next, read through your document to check that your data is accurate and makes sense. Be 

sure to double check calculations to make sure they are calculating correctly.  
• Be sure to use reference materials to verify that the data is correct.  
• If something is entered at a quote from a reference, you need to use MLA or APA format to 

cite the sources.  

Processing Mail Considerable diversity exists among mailrooms found in various organizations. The 
type and number of personnel required in the mailroom is determined by the size of the organization 
and the variety of functions performed in the mailroom. Different types of equipment can be found in 
most mailrooms. Automatic envelope emptiers remove the contents of the envelopes and disposes of 
the empty envelopes. Label preparation equipment enters the name and address on a label and then 
adds the appropriate bar code for each zip code. Inserting equipment is used to stuff inserts into 
envelopes. Electronic scales are used for weighing mail and displaying the actual amount of postage 
needed on the item weighed. Bundling equipment is used to tie and bundle packages. Stamping-
sealing equipment is used to stamp and seal envelopes, postmark envelopes, stack envelopes, record 
the amount of postage used, and count the number of envelopes processed. Opening equipment is 
used to automatically open mail by trimming off a small part of the envelope. Address-printing 
equipment is used to print mailing addresses on envelopes and other type of mailing containers.  

Computer Literacy With the use of computers, people are able to accomplish certain tasks much 
faster. Computers help calculate numbers, create documents in a presentable style, store data, and 
find information on just about everything through the use of the Internet. A computer is made up of 
hardware, software, and peripheral devices. The hardware of the computer is the components that 
make up the computer system. The software for the computer tells the computer how to do what you 
are telling the computer to do. The devices for the computer include the monitor and keyboard. The 
CPU, or central processing unit, is where the computer processes data. The computer will hold the 
data in memory until it can be processed. There are a variety of types of computers that vary in size 
and capability. The desktop, laptop, PDA, notebook, tablet, supercomputers, and microcomputer are 
some examples of computers.  
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Some of the terminology that you might hear associated with a computer might be RAM and ROM. 
RAM, random access memory, holds data while it is waiting to be processed. ROM, read only 
memory, contains the programs that start the computer and control the input and output. Through the 
use of wizards, creating a document can be fairly simple even if you have not used the program. A 
computer wizard will help you step by step in creating certain documents. These wizards are usually 
found in every word processing program. If you still are having trouble using a program or cannot 
figure out how to perform a certain task, you can always click on the Help menu. After you click on 
Help menu, you can type in a question and through a search, you will find a list of results from which 
to choose.  

Technology has taken another turn since the use of the Internet. The Internet allows a person to talk 
to anyone anywhere; you have access to any type of information you need. Through the use of e-mail 
you can send letters in a matter of seconds. Some of the main vocabulary associated with the Internet 
might be www, home page, sites, and web browsers. WWW stands for World Wide Web, which 
allows people to finding information. A home page is like a title page of a book. A user can have 
their own web site to share information with others. When you go to a website, the first page is 
usually called the home page.  

Internet Technology The Internet can be thought of as a giant database containing millions of 
records. To navigate through all the records to find the file you want, you will need to use a special 
method of searching called search engines. Search engines catalog the Internet's contents and create 
an index or master list. Some examples of search engines are: InfoSeek, Lycos, WebCrawler, Dog 
pile, Yahoo, and Google. In the search textbox, you can enter a word or phrase, and it will bring up 
information that you are looking for. You can do almost anything when using the Internet. You can 
check mail, talk to friends, go shopping, get airline tickets, and research different topics. When first 
using the Internet on the computer, you will need a modem in your computer. A modem is a device 
to connect the Internet through a telephone system. The Internet today can also be wireless. Wireless 
Internet is like a satellite. You need a device to track where your Internet is and the computer 
network being used. It is important to have a login name and a password for the accounts you open 
on the Internet. Once connected, you need to know the address of the website that you are trying to 
find. The first step is typing http://. Http stands for Hypertext Transfer Protocol. Next you type in 
www. That stands for the World Wide Web. Next is the descriptive word identifying the account. 
Finally the domain--COM is one of the top domain names that can be used. Others are .ORG, .GOY, 
.EDU, .INT, .NET and .MIL. Email is another computer function that is very popular. Email stand 
for electronic mail. There are many different sites you can go to for Email such as: Hotmail, Yahoo, 
and Lycos. You could type in "Email" in one of your search engines, and you will find many other 
email systems. When you get to an email system, you will need to set up an account. You will have 
to follow the directions and get a login name and password. When sending email, you will need to 
know the other person's email address. Email addresses consist of userid@domain.name
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